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Abstract

This Master’s dissertation investigates the possibility of implementing the concept of
inverse motion form finding in a commercial software. The inverse motion approach
finds the initial, undeformed geometry of a design such that it obtains its desired
design shape when service loads are exerted on the design. The implementation is
limited to static mechanical loads on three-dimensional geometries.

A previously developed non-commercial code was used for verification of the imple-
mentation by comparison of nodal values. The implementation was deemed successful
and thus the code may be used for further development.

Several examples of applications for the inverse motion form finding model are
presented. Although the examples are simplified, they show that the model may be
used for a large variety of products. This includes both technologically advanced
designs and everyday objects in addition to components commonly used by multiple
industries.
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1 Introduction

1.1 Background

When a load is exerted on an object, the object deforms. These deformations may
be calculated using the finite element method with use of forward motion problem
formulation. This formulation uses the design in its undeformed state to calculate
the shape after the load has been applied, as seen in Figure 1. For a design which
is sensitive to the shape in its loaded state, these deformations may lead to what is
considered an unacceptable shape of the loaded geometry even if the deformations are
relatively small.
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Figure 1: Illustration of the forward motion form finding formulation. The deformed
configuration, €2, is obtained from the forward motion solution procedure with the
rectangular box as the design geometry.

For designs where the shape of the geometry in its loaded state is of major im-
portance, the inverse motion problem formulation may be used instead of the for-
ward motion problem formulation. The inverse formulation approaches the problem
backwards compared to the forward formulation. Instead of designing the object in
its undeformed geometry and calculating the deformation after loading, the inverse
formulation uses the desired, loaded geometry as the reference configuration and com-
putes the shape of the geometry as it would be when loads are not applied, as seen
in Figure 2. This allows for the object to be manufactured in its unloaded state. and
when loads are applied the geometry of the object will deform into the desired shape
for the application of the object.
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Figure 2: [llustration of the inverse motion form finding formulation. The undeformed
configuration, €y, is obtained from the inverse motion solution procedure with the
rectangular box as the design geometry.

1.2 Objective

This thesis is motivated by the observation that, to the writer’s knowledge, inverse
motion form finding is not offered in commercial software. By implementing the
inverse motion problem formulation in commercial software the model can easily be
applied on geometries within the commercial software framework. This allows for
the full project, from creating the desired geometry in its loaded state, to meshing,
setting boundary conditions and calculating the undeformed geometry in its non-
loaded state, to be done within a single software framework. The solvers implemented
in commercial software may also increase the computational speed and thus reduce
the computational costs as the solvers often are programmed to increase convergence
rates, thus finding an acceptable solution faster than a simpler, non-commercial code
would. In addition, the goal is also to implement code that can be used for further
research and development.

1.3 Limitations

It was decided that the implementation should be made using existing, non-commercial
code packages, in the form of FORTRAN 90 modules, developed at the Division of
Solid Mechanics at Lund University. The packages were translated from FORTRAN
90 to FORTRAN 77, and modified to be compatible with ANSYS Mechanical as user
programmable features (UPFs), a tool for tailoring the ANSYS program to one’s needs
[1]. The reasons for using these packages as a base for the UPFs were:

e to use a proven, functioning model
e to avoid using copyright protected code from other organizations

e to create a recognizable code structure to facilitate for further development of
the code at the Division of Solid Mechanics at Lund University.

By using the code packages the development of the UPF's was limited to handle prob-
lems of similar nature to problems solvable by the code packages. More specifically,



the inverse motion UPFs were restricted to be used for static, mechanical, three-
dimensional problems using the Neo-Hookean material model for hyper-elasticity with
a mesh consisting of 8-node brick elements.

2 Theory

For better understanding of the inverse motion problem, both the traditional forward
motion problem and the inverse motion problem are described in detail here. Thereby,
a comparison between the two formulations can be made and the differences between
both formulations may easily be distinguished.

Both problems considers geometrically non-linear elastic structures and the kine-
matics are defined as followed. The body of the structure is at time ¢y considered
to be undeformed in its reference configuration €2y. When deformed at any instance
t > ty, the body occupies its current configuration denoted as €2. The configura-
tions 2y and €2 have boundaries denoted as 9€)y and 0f) respectively. The outward
normal unit vectors to bodies 2y and (2 are denoted m° and m respectively. The
position of a particle in the reference configuration €2y is described by the position
vector ¢° = [z] x5 x3]. At time ¢ > t, the position of the particle is described by
the position vector @ = [x; x9 x3] which gives the coordinates of the particle in the
current configuration €2. Note that the element notation in most cases dropped is
throughout the derivations for improved readability. When needed, exceptions are
made to clarify the use of element notations.

2.1 Forward motion

Consider a particle at position x° in the reference configuration {2y. As the body is
deformed the motion to position & at time ¢, in the current configuration €2, can be
described by the mapping

x = p(x°t) (2.1)

The difference between the particle’s position vectors can be defined as the displace-
ment u of the particle as
r=z°+u (2.2)

For each discrete element, the displacement w can be described as [2]
u’(x°,t) = N°(x°) - a“(t) (2.3)

where a® is the elemental nodal displacement vector and IN® contains the global shape
functions, which are defined differently for each element type.

As illustrated in Figure 3, in a region around the particle, the deformation can be
described by the deformation gradient F', as

F = Vo & (72} (24)

where V| denotes the coordinate gradient with respect to the reference configuration
and ® is the dyadic product operator [3].
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Figure 3: Schematic illustration of the forward mapping @ from the reference config-
uration Qo to the deformed configuration €2 with deformation gradient F'.

Consequently, the components of the deformation gradient tensor are defined as
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Due to the linear relation of Equation (2.2), the deformation gradient can also be
expressed as [4]
F=I+D (2.6)

where I is the unit tensor and D is the displacement gradient tensor defined as
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(2.7)

From Equation (2.3) it can be seen that w is a function of the shape functions N
which in turn are functions of the position in the reference configuration. Thus, the
displacement gradient tensor can be calculated as

~ ON®

D
ox°

a’ (2.8)

for each element e.
The right Cauchy-Green deformation tensor, defined as

C=F"F (2.9)



as well as the determinant of the deformation gradient tensor
J =det (F) (2.10)

which is useful when defining constitutive relations, such as the strain energy function,
for the continuum. The strain energy function in the reference configuration, wy,
describes the potential energy per unit volume stored when strain is introduced in the
material and can be found through experiments [5]. Here, use will be made of the
strain energy function identified for the Neo-Hookean constitutive relation, discussed
later in the report.

The linear mapping, seen in Equation (2.1), is assumed to be bijective, mapping
one element in the reference configuration to exactly one element in the current con-
figuration and vice versa. This prohibits the determinant of the deformation gradient
from being equal to zero. In addition, the determinant of the deformation gradient
describes the volume ratio between the reference configuration and the current config-
uration [6]. A negative value for J would turn the material inside out, which is not a
desirable behaviour in this model. The determinant would also have to pass through
zero to reach negative values, which is as stated not allowed. Thus, the determinant
of the deformation gradient is enforced to follow the constraint J = det (F') > 0.

From the strain energy function, with use of the deformation gradient, the first
Piola-Kirchhoff stress tensor P can be calculated as

811)0
P=— 2.11
oF (2.11)
which in turn may be used to calculate the Cauchy stress, o, as
1 T
oc=—-P -F (2.12)

J

as used in Wallin et al. [3]. A different, but similar, approach is to utilize that the
second Piola-Kirchoff stress tensor may be calculated as

. 8'11}0
S=-2 (2.13)

where wy = wo(E) and E is Green’s strain tensor defined as [2]
1
E = §(C—I) (2.14)

thereby enabling the second Piola-Kirchhoff stress tensor to be derived as

8w0
S=255 (2.15)

The first Piola-Kirchhoff stress tensor P in Equation (2.12) can be expressed as P =
F - S, which gives the expression
1

aszﬂS-FT (2.16)



The second Piola-Kirchoff stress tensor obtained from Equation (2.15) may then be
inserted into Equation (2.16) to obtain Cauchy’s stress tensor, o. This tensor is
suitable for describing how the stress on an internal surface in a material can be
treated in the same way as the traction from external forces acting on the actual
surface of the material [7].

The boundary conditions are defined by the displacement field ,¢o, and the traction,
t, in the reference configuration. The displacement and traction boundary conditions
are set as

p=¢ (2.17)
and
t°=1t° (2.18)

on their respective specified boundaries 0y, and 9y, as seen in Figure 4. The
displacement boundary conditions are limited to set a fixed constraint on the struc-
ture such that ¢ = 0, whereas the traction boundary conditions may take on any real
values, zero included. Thus, the traction and displacement boundary conditions are
prescribed over the entire surface of the structure as 9€) = 9z U 08205. Addition-
ally, traction boundary conditions should not be prescribed on the same boundary as
displacement boundary conditions such that 0Qgz N 0y, = 9.

0.

Figure 4: [llustration of displacement boundary conditions, 0, and traction bound-
ary conditions ,0Q, applied to the reference configuration for the forward formula-
tion.

If the assumption is made that no body forces are present, the elastic potential
related to the elastic boundary value problem can now be formulated as

;C()(SO) = / U}(](F7 a:o)dvo — / (PiodSO (219)
Qo 50
In variational form the potential can be expressed as
dLo(p, dp) = / OF : Pdv° —/ dpt’ds® =0 (2.20)
Q 0

9



where the traction t° is defined as t° = P - n° on 9. The variational potential
now corresponds to the strong form of the equilibrium

Vo -P=0 (2.21)

Finally Equation (2.12) may be used to obtain the variational format in the deformed
configuration as

L (p,dp) = / oD : odv —/ dptds =0 (2.22)
0 09

where §D is defined as 6D = (V ® 0¢)sym, which refers to the symmetric part of
the argument. The boundary conditions in the current configuration follow the same
principles as in the reference configuration [3].

2.2 Inverse motion

With the previous introduction to the forward motion problem, the inverse motion will
now be described so that the differences between the two models may be identified.
In the forward motion problem, the mapping from the undeformed, reference config-
uration to the deformed, current configuration is defined in Equation (2.1). For the
inverse motion problem the mapping from the deformed configuration to the reference
will be defined as

x° = ¢(x, 1) (2.23)

Analogous to how the deformation gradient, F', used in the forward motion problem,
was defined by the mapping ¢ in Equation (2.4), the deformation gradient in the
inverse motion problem is defined as

F=Veae (2.24)

where V denotes the gradient operator with respect to the deformed configuration.
Additionally, the deformation gradient for the inverse motion problem, illustrated in
Figure 5, may be obtained by calculating the inverse of the forward motion deforma-
tion gradient as

f=F" (2.25)

To define the constitutive relations, similar to Equation (2.9), an inverse right Cauchy-
Green deformation tensor is introduced as

c=f"f (2.26)

This inverse right Cauchy-Green deformation tensor can be shown to be equal to the

inverse of the left Cauchy-Green deformation tensor, B~' = (F . FT)fl, in accor-
dance with the associative properties of matrices as

1

fT . f _ FT*1 ] F_l _ (F . FT)* (2.27)

10
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Figure 5: Schematic illustration of the inverse mapping ¢ from the €2 to €y with the
mverse deformation gradient f.

Consequently, the determinant of the deformation gradient for the inverse problem,
j = det f, is equal to the inverse of the determinant of the deformation gradient for
the forward problem as

1 1
j=detf=detF'=—— =— 2.28
j=detf=de det F  J (2.28)
due to the invertibility of the deformation gradient [4]. It can now be concluded that
the strain energy in the deformed configuration is related to the strain energy in the

reference configuration as
w = jwy (2.29)

The strong form of the equilibrium shown in Equation (2.21) can be multiplied with
F7 to obtain

as

F' - Vy-P=V.(F'-P)—P:V,@F =0 (2.31)

The Eshelby stress tensor, 3, in Equation (2.30) can be considered a natural quantity
and is defined as
Y =wl - F'P (2.32)

where I is the identity matrix. The quantity g, is defined as

_ Ow(F,z°)

8o = Dz (2.33)

This body force is considered as an internal configurational force and can be seen as a
force that holds together the material structure in every deformed configuration and
acts as a resistance to structural changes within the material [8]. The weak form of
the equilibrium may now be obtained by multiplying Equation (2.30) with the weight
function d¢ and integrating over the domain, €2, as

Vo 0o: O'dvo—i—/

Qo

S - godv® — / S -t°ds® =0 (2.34)
89

Qo

11



where t° is the traction defined as t° = o - n° and n° is the normal unit vector to the
surface 0€)y in the reference configuration. As the deformed configuration, €2, is the
known domain for the inverse motion problem, the weak form needs to be modified to
be integrated over the computational domain €2 instead of {2y as shown in Equation
(2.34). To do this, the Eshelby stress tensor, o, is transformed into a Piola-stress type
tensor, p, by use of a Piola transformation, which results in

p=j=- 5" (2.35)
This energy momentum tensor may also be calculated from the strain energy as
ow
= — 2.36
P=57 (2.36)

The weak form of the equilibrium integrated over the deformed configuration may
now be obtained as

W(¢,5¢):/QV-cScb:pdv—l—/ﬂéq’)-gdv—/méq’)-ttds:o (2.37)

where the configurational force in the deformed configuration is introduced as g = jg,,
the traction t; is defined as t; = p - n and n is the normal unit vector to the surface
0f) in the deformed configuration. The non-linear dependency of ¢; on ¢ imposes a
challenge on the computational aspect of Equation (2.37). However, this dependency
vanishes if the model is restricted to only allow for constant traction, i.e. dead loads
[9].

To make it more comparable to the forward motion problem and to facilitate for
the modification of the forward motion into the inverse motion problem, the weak form
in Equation (2.37) may be expressed with use of the Cauchy stress tensor o. The
virtual displacement used in the inverse problem may be expressed with the weight
function from the forward problem and the inverse deformation gradient as

Sp=—dp- f (2.38)

As a result, the weak form can be expressed as

W(,dp) = / o: dDdv — dp - tds =0 (2.39)
Q 007

where the Cauchy stress tensor is defined as
oc=wl—-f"p (2.40)

thus making the weak form a subject to the inverse deformation gradient.

2.3 The Newton-Raphson iterative solution method

To solve the equilibrium equations associated with the balance of linear momentum,
the Newton-Raphson method will be used. This numerical iterative method is based
on a Taylor series expansion around the current state as

SLHY = 6L + doL! (2.41)

12



where 6L is the variational equation considered and the superscript refers to the
iteration. Equilibrium is found when the left hand side of Equation (2.41) reaches
zero. In other words, the term on the left hand side, here referred to as the residual,
is an indication of how far our numerical estimate is from equilibrium.

To satisfy the balance of linear momentum for a static problem, a residual force
equation may now be defined which calculates the residual vector, G. When the
residual vector is equal to zero, the system is at equilibrium. By applying finite
element formulation to Equation (2.41), the residual equation is expressed as the
difference between the internal and external forces as

G - Fint - Fea}t (242)

for static equilibrium of the forward motion problem. The tangential stiffness matrix,
K, is the Jacobian of G with respect to the displacement field and is used to esti-
mate the equilibrium conditions. The purpose of the Newton-Raphson scheme is to
approach the actual equilibrium. Due to this prediction-based behaviour, the actual
equilibrium where F;,; — F.,; = 0, will not necessarily be possible to find. Therefore,
a tolerance, ¢, may be set for the residual equation, telling the algorithm to accept
calculated residuals below a certain value so that the program converges to an accept-
able solution. The lower this tolerance is set, the more accurate the solution will be.
However, lower residual tolerances may require more iterations than higher residual
tolerances. Thus, lower residual tolerances may lead to higher computational costs.
In addition, extremely low values may cause convergence problems. Commercial soft-
ware such as ANSYS use an adaptive tolerance which is dependent on the degrees of
freedom in the system.

When large external loads are applied, numerical issues may become apparent,
causing the solution to crash. To avoid this problem, the external load may be divided
into load increments, dF, which can be applied in load steps adding up to the total
external load. The Newton-Raphson iteration scheme may be applied in each load
step and thus the program should converge on a solution for each load step. The
pseudo-code for the Newton-Raphson algorithm for the static problem is shown in
Box 2.1.

13



e For load step n = 1,2,...

— Apply external load
Feot = Fepe + dF
— Equilibrium iteration i = 0,1,2,... until |G| < €
x Calculate:
- Tangential stiffness matrix K

- Displacement increments da from

Krda =—-G

- Displacement vector
a; 1 =a; +da

- Stresses and strains

- Internal forces F;,,;

- Residual G = F.,; — Fys

— End equilibrium iteration loop

e End load step loop

Box 2.1: Pseudocode for the Newton-Raphson algorithm

2.4 The Neo-Hookean material model

For small deformations of any elastic material, the stress-strain relationships can be
described as
c=F-¢ (2.43)

where o is the tensile stress, F is Young’s modulus and ¢ is the strain. This relationship
is a generalization of Hooke’s law

F=k X (2.44)

where F' is a load, k is a stiffness and X is a displacement. The purpose of this
model is to find the the deformation of a body as well as the body’s internal stress
distribution when the body is subjected to certain forces or displacements. This
simple mathematical model is regarded to be applicable to any ideal material that
obeys Hooke’s law in a body subjected to small deformations.

For large deformations the above generalization is insufficient. Instead, a model
such as the Neo-Hookean elasticity model can be utilized when larger deformations
are expected. This model, which is a natural extension of the stress-strain relationship
used for small elastic deformations, is known to capture the behaviour of a wide range
of elastic materials such as polymers and rubber [10].

14



To model the behaviour of the body when subjected to loads and restricted by
boundary conditions, the elastic energy stored in the body can be used for any specified
strain. For the Neo-Hookean model, this strain energy per unit volume in the reference
configuration is given as [3]

wy = % G(ﬁ ~1)—1In J> + % (J723 tr (C) - 3) (2.45)

where J is the determinant of the deformation tensor as shown in Equation (2.10) and
tr (C) is the trace of the Cauchy-Green deformation tensor obtained from Equation
(2.9). The shear modulus G and the bulk modulus K are defined as

E
G = m (2.46)

and B
K= m (2.47)

where E and v are the Young’s modulus and Poisson’s ratio. In accordance with
Equation (2.15), the stress response when the body is deformed may be calculated as
the second Piola-Kirchoff stress tensor

6w0 K _ _ C _
Si =256 =5 (SP-1)C;t+ G- T <5 — %qjl) (2.48)
which can be derived by using that
oJ oJ 0F; J _, |
p— == — .. 2'4
where the first product can be identified as
O~ det(Fy) - By (2.50)
ij

as shown by Holzapfel [11]. The strain energy per unit volume in the reference config-
uration may be used to calculate the material tangent matrix D by taking the second
derivative of the strain energy with respect to the Cauchy-Green deformation tensor.
Additionally, the Kronecker’s delta is introduced and denoted as §. This results in
the following fourth order tensor

Dijr = a1 - Gt - Ot — ap (Cit - 655 + Cj0w) + a3 (G- it + C 't - ) (2.51)
which can be derived using that

oC; L, R
aCZz =75 (Ct- Cljl +Cit- Cjkl) (2.52)

15



and where the quantities a;, as and a3 in Equation (2.51) are given by

2-G
a; = (K I+ TJ—2/3 : Cpp) (2.53)
2.

ay = (TGJQ/?’) (2.54)

K
az = (—5 (JP=1)+G- rm%) (2.55)
In the deformed configuration, the strain energy per unit volume may be expressed

e 1 1 1
_ - - 2/3 1

w—ij(§(j —1)+lnj)+er(j/ ) (2.56)

Consequently the Cauchy stress may with Equations (2.36) and (2.40) be expressed

as
1

1 . _ _
Oij = 5 (3 _]> 5ij + G- ]5/3 <Cz‘j1 - gcppl ’ (Sij) (2'57)

The consitutive relation shown in Equation (2.40) may be linearized to obtain the
material stiffness tensor associated with the inverse motion problem as

Jo
Ccol = — 2.58
57 (2.58)
Given Equation (2.12), this tensor may be expressed as
C/l=ocxf —f'®o—0oaf'—d:(Iaf") (2.59)

where the non-standard dyadic products ® and ® are defined from [ARB| : H =
A-H" B" and [A®B]: H = A- H - B", where A, B and H are second order
tensors [3]. The tensor d in Equation (2.59) is the conventional material tangent
stiffness used in an updated Lagrangian formulation, which here is given as a function
of the deformation gradient and the second derivative of the strain energy function
with respect to the Cauchy-Green deformation tensor defined in Equation (2.9) as

d =

|
"
Q|

: (FQF) (2.60)

With use of Equations (2.58), (2.59) and (2.60) as well as the strain energy per unit
volume in the reference configuration from Equation (2.45), the material tangent
stiffness for the inverse motion problem may now be obtained as

d=b - I@I+b(I®c'+c ' @I)+by (IR +IRI) (2.61)

where
2.G-j%3
— 4t

bh=K-j 2+ 5

r(c™) (2.62)

16



by (2.63)

1
by = —EK (G72-1)+

and c is the inverse right Cauchy-Green deformation tensor as defined in Equation
(2.26). This format gives the advantage of allowing the stiffness tensor associated
with the inverse problem to, through a pushforward, be expressed in terms of the
conventional material tangent stiffness used in an updated Lagrangian forward motion
formulation [3].

o (¢ (2.64)

2.5 The Stiffness Matrix for the Total Lagrangian Formula-
tion of the Forward Motion Problem

In the total Lagrangian formulation of a Newton-Raphson scheme, the calculations
are made with respect to the coordinates in the undeformed configuration. With this
premise, the finite element formulation of a static loading situation can be based of
the principle of virtual work [2]. Work is defined as the force acting on a particle
over a displaced distance in a certain direction. A displacement in the same direction
as the force gives positive work. When the force acts in opposite direction to the
displacement, the work is negative. Therefore the work can be defined as the dot
product of the force and the displacement which results in a scalar quantity. The
virtual work, V), also behaves according to this displacement-force relation. As the
virtual work therefore is a scalar quantity, it can be partitioned so that each particle
does an infinitesimal amount of virtual work, 6V; for a total number of particles,
N. Additionally, we assume that the particles do not interact with each other. For
static equilibrium the sum of these contributions to the virtual work will be zero in
accordance with

N
Wi+ 0Vat . +0Vy =) V=0 (2.65)
i=1
However, for static equilibrium a problem arises. If we have finite contributions to the
work, we would need to have finite displacements, but at static equilibrium the dis-
placements of all particles are zero. To deal with this, a hypothetical, variational dis-
placement, du;, is introduced for each particle i. As the particles are non-interacting,
the directions of the variational displacements are arbitrary as long as they obey any
constraints in the system. Consequently, the virtual work for static equilibrium may
now be expressed as

N
V=) (F" - du,) (2.66)
=1

describing the virtual work as the sum of the variational displacement and applied
external load for each particle [12]. For the forward motion problem the virtual work
is commonly used to calculate the stiffness matrix and residual vector in the finite
element formulation. The virtual work may then be defined as the difference between

17



internal and external virtual work as

VY = Vint - Vext (267)
where
Vint :/ tr (5E[|S|j)d?]o (268)
and
Veut = / dSult’ds® — / p°ou’ bdv® (2.69)

Here, p° is the mass density in the reference configuration, b are body forces, Sg is a
symmetric second order Piola-Kirchoff stress tensor defined as

So=F'P (2.70)

and the variation of the Green-Lagrange strain tensor, d Eq is defined as

§Eg = - (F" . 0F + 6F" - F) (2.71)

N | —

where the variational deformation gradient, 0 F', is calculated from the variational
displacements. A truncated Taylor expansion around the current known state w with
an external loading to find equilibrium at w + du gives

V(u+du,du) =V (u,du) +d(V(u,ou)) (2.72)
Which, if assumed that V,,; does not depend on displacements, results in
d (Vine (u,0u)) = =V (u, du) (2.73)

This expression can then be calculated as

d (Vine (1, 50)) = / tr (d(6Ew)Sadv® + / tr OBodSo)dw  (2.74)
which with use of that
d(6Ep) = %(dFT -OF +0F" . dF) (2.75)
and the assumption that
dSo =D : dEg (2.76)

allows for the tangential stiffness matrix, K1 to be obtained from

(Vo (s 50)) = [

vO

tr (6F - Sp - dFT)dv° +/ SEq: D : dEqdv® = da- K1 - da
’ (2.77)
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With help of the element shape functions, IV, the finite element formulations may
now be introduced as follows. For a three-dimensional, 8-node brick element the
shape functions may be defined as

No= 148 (140 (1-0)

Ny= S(1=8) (14 (1-0)

Ny= ~(1—6-(1—p)-(1-0)

8
Ni= 149 (1-p-(1-0)

| (2.78)
No= 5148 (14 (1+)
No= 5(1-8) (14 (1+)

Ne= c(1=8-(1—p)-(1+()

Ne= S48 (1= (1+)
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With the shape functions the displacement field u®(x°), for each element e, can be
approximated as

[N, 0 0] ’ [y |
0 Ny O ao
O 0 M as

Ny 0 O ay
0 Ny O as
0 0 Ny ag

Ny 0 O ar
0 N3 O as
0 0 N ag
N, 0 O ay
0 Ny O ain

(@) = N(@®) af = | - Ml o (2.79)
Ns 0 O a3
0 Ny O as

0 0 Ns ais
Ng 0 O Q16
0 Ng O ary
0 0 Ng as
N, 0 O alg
0 N; O aoo
0 0 Ny a9y
Ng 0 O a9
0 Ng O ao3

0 0 Ng_ 24

where a;_3 are the displacements in the three dimensions in the first node, a,_¢ are
the displacements in the three dimensions in the second node and so on. The variation
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of the Green-Lagrange strain tensor may now be expressed in the format

which when expanded may be written as

0FE =

O0uy

ox°

0duy

ay°

Odu,

0z°
Oduy, ~ Oduy dduy Oduy,
0y° dx° dzx° 0Oy°
Odu,  Odu, O0uy Oduy,
0z° ox° dzx° 02°
Oduy . odu, O0ug Oduy,
0z° dy° | Oy° 0z°

rioih
OBy,
5Ezz
OF = (2.80)
SE,,
5Ezz
_5Eyz_
% Oduy ~ Ouy Oéuy  Ou, Odu.
0x° Ox° 0x° Ox° 0x° O0x°
% Oduy ~ Ouy O6uy  Ou, Odu.
oy° 0y° 0y° 0Oy° y° Jy°
% Oduy  Ouy O6uy  Ou, Odu.
0z° 0z° 0z° 0z° 0z° 0z°
Ouy Oduy ~ Oduy Oduy — Ouy Oduy, — Obu, Odu,  Ou, Odu,
ozx° Oy° dzx° 0y° dz° 0y° dzx° Jy° oxz° Jy°
Ouy Odu, ~ Oduy Odu,  Ouy Odu, — Odu, Odu,  Ou, Odu,
0zx° 0z° dzx° 0z° 0z° 02z° dzx° 0z° 0x° 0z°
Ouy Odu, ~ Oduy Odu,  Ouy Odu, — Odu, Odu,  Ou, Odu,
0y° 0z° dy° 0z° oy° 0z° dy° 0z° 0y° 0z° |
(2.81)

To more easily manage the computations, two linear operators V, and V, as well as
a displacement dependent matrix A(w), may be introduced so that the variation of
the Green-Lagrange strain may be written as

§E = (B} + A(u) - Hy) a = By - da (2.82)
where .
B,=V,-N 2.83)
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and the displacement dependent matrix, A(u), is defined as

for a three dimensional problem.

Ou,,
0x°

0

0

Oy,
oy°
Ou,
0z°

0

0
ou,,
0y°

0

ou,,
ox°

0

ou,,
0z°

0

0
ou,
0z°

0

ou,

0x°
Oy,

0y°

term of Equation(2.77) results in

Ou,
ox°

0

0

Ou,
0y°
Ou,
0z°

0

0
Ou,
0y°

0

Ou,,
0x°

0

Ou,
0z°

0

0
Ou,
0z°

0

Ou,

ox°
Ou,

dy°

ou,
0x°

0

0

ou,
oy°
ou,
0z°

0

0
ou,
0y°

0

ou,
ox°

0

ou,
0z°

0

0
ou,
0z°

0

ou,

0x°
ou,

oy°

(2.85)

(2.86)

By introducing a matrix formulation, the second

OEs:D :dEy =6E" - D-dE

(2.87)

where similarly to Equation (2.82), the incremental stress may be calculated as

dE:Bo'dCL

The second term in Equation (2.77) may now be written as

/ 5ED D dEDdUO ==
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Now considering the first term in Equation (2.77), the variation and the increment of
the deformation gradient for a three dimensional case may be written as

o]
§F = |ofF (2.90)
[ of; |
i
dF = |df] (2.91)
L |
This gives the following relation:
off - Sy - dfy
tr (6F - Sp - dFT) = tr |6fs - Sp-dfy| = (Vo -du) ' R(V, - du) (2.92)
6fs - Sp - dfs
where
S 0 O
R=|0 S5 0 (2.93)
0 0 Sg
By noting that B B
Vo-du:VO-N-da:Hg-da (294)
Equation (2.92) results in
tr (OF - Sp - dF") =6a” -H - R-H, - da (2.95)

and thus, the tangential elemental stiffness matrix for the forward motion problem
may be obtained from Equation (2.77) for each element as

K5 = / (BY - D - By)dv° —I—/ (H - R-Hg)dv° (2.96)
where element notation has been reintroduced and the first term is related to the
material model and the second term is related to the non-linear geometry changes [2].
The elemental stiffness matrices, K7 for each element e may then be assembled into
the global stiffness matrix, K1 for the entire system as

Kr=|]J K5 (2.97)

e=1

where n. is the number of elements included in the system. The stiffness matrix along
with the residual vector can now be used to solve for the incremental displacements
da;,, for the upcoming iteration 7 + 1 as

Koy -dai, = —G(a;) (2.98)
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where the following displacement relation holds for a constant load level:

a;11 = a; —+ dai (299)

2.6 The Stiffness Matrix For the Total Lagrangian Formula-
tion of the Inverse Motion Problem

For the inverse motion problem, the finite element formulation may be derived from

the variational weak form of the equilibrium equation shown in Equation (2.39). With

use of the shape functions, for an 8-node brick element defined in Equation (2.78),
the interpolation, ¢", for the inverse motion field, ¢, may be introduced as

Nnode

o(z) = ¢'(x) = Z N'(z)- ¢' (2.100)

where, n,,4. is the number of nodes and ¢ represents the nodal values of ¢ for the
node with shape function N?. For the inverse motion the shape functions will be
functions of the fixed, deformed coordinates, & as these are the known coordinates of
the system. Using the Galerkin method, as described by Ottosen and Petersson [13],
the variation d¢ from Equation (2.39) may be interpolated into d¢", as

Nnode

S ~ dp(x) = Z Ni(z) - d¢p' (2.101)

where d¢° are the nodal values of . The residual equation may now be defined as
. Nnode ) ) Nnode ] )
SL" (", 5¢") = / S d¢t (0 VN dv — / N Sp' Ni-Eds  (2.102)
Qi1 5

Qg =1

by inserting Equations (2.100) and (2.101) into Equation (2.39). The deformed domain
Q) is known and fixed for the inverse problem and the external loading ¢ is assumed to
be independent of the displacement field. A linearization of Equation (2.39) results
in the incremental part of Equation (2.41) to be expressed as

doL = / 6D :C% :dfdv (2.103)
Q

Inserting Equations (2.100) and (2.101) into Equation (2.103), results in

doLh = / Y et (VN-CoT VNI - dgdv (2.104)
Q

i=1 j=1

through which the asymmetric stiffness matrix, K%, can be obtained as
K"V = / VN'.C% .V Nidv (2.105)
Q
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and through Equation (2.102) the residual vector, G, may be defined as

GZ’:—/ (- VN)dv— [ N'-tds (2.106)
Q 00

This allows for the Newton-Raphson scheme from Equation (2.41) to be expressed as

Nnpode

Y KV.d¢) =G Vi (2.107)
7j=1

Consequently, in similarity to the forward motion problem, the global stiffness ma-
trix may be assembled and used to solve for the inverse motion displacement field
increment, d¢ in Equation (2.107).

3 Method

The main goal of this project is to investigate the possibilities for implementing inverse
motion form finding in commercial software. There were several commercial finite
element software to choose from as many of them support user-implemented element-
and material routines. The implementation of user routines will vary among different
software, but the general approach will be similar as the finite element algorithms
in most software would have similarities. ANSYS was chosen as the commercial
software to work with. More specifically, focus was set at using the Static Structural
analysis system within the multiphysics framework "ANSYS Workbench”. This gives
the possibility of managing a large part of, if not the entire, structural project in one
program. If desired, one may create the geometry and the mesh, set up the analysis
with constraints, loads etc., run the simulation and view the results all within the
framework.

To implement user defined routines into ANSY'S, use is made of what is called
"User Programmable Features” (UPFs). These FORTRAN 77 subroutines can be
written to modify your solution in multiple ways. Some examples of what you can do
with UPFs are [1]:

define the material behaviour

define new finite elements

monitor quantities in existing elements

specify load types
e create a customized design optimization routine

There are multiple ways of calling the user programmable features into your ANSYS
project. The UPFs require additional software to work that is not supplied by the
ANSYS program itself and therefore a manual on how to get started using UPF's, and
one way to call UPFs into ANSYS, will be included in Appendix A of this report.
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For this research, two UPF routines were written. One routine that defined the
material behaviour according to the Neo-Hookean material model for inverse motion,
and one routine that defined a new element for inverse motion in the total Lagrangian
formulation. The element routine specifies the shape functions and their derivatives,
then it calculates the deformation gradient, calls the material routine and then cal-
culates the internal force vector as well as the stiffness matrix. The material routine
calculates the stresses and the material stiffness matrix.

The two subroutines were largely based on material and element modules devel-
oped at the Division of Solid Mechanics at Lund University. The code from the
modules was translated from FORTRAN 90 to FORTRAN 77 and modified to fit
into the ANSYS interface. As an example, the input and output parameters of the
element routine needs to be understandable by ANSYS. Therefore an example ele-
ment UPF, distributed by ANSYS, was used to obtain the correct routine input and
output. However, as the material routine is called within the element routine it is
in this case not necessary to use the same input and output structure in the inverse
material routine as in the example material UPF distributed by ANSYS. The input
output structure for the material routine simply has to be the same as the one used
when the material routine is called in the element routine.

The FORTRAN 90 modules had previously been used to compute inverse motion
form finding with a non-commercial finite element code and the code had been con-
firmed to work. Thus, the results obtained with the use of the UPFs in ANSYS could
be compared to the results obtained with the non-commercial code. This was done by
creating the exact same problem setup in the non-commercial code as in ANSYS. By
using the same geometries, mesh sizes, boundary conditions etc., the resulting nodal
displacement values from the non-commercial software should match the nodal dis-
placement values obtained with the UPF solution in ANSYS. Thus, one could verify
if the implementation of the code modules into the UPFs was adequate. Multiple
geometries were tested to see that the UPFs could handle systems of different sizes,
different mesh scales and different loading situations. Additionally, other geometries
are included to show the result of the inverse motion form finding on example geome-
tries that could be used for various applications.

Note that the UPFs are not developed to handle general problems. Another man-
ual is included in Appendix B to explain what inputs are needed and how to set up
your model in order to use the inverse motion form finding UPFs in ANSYS Mechan-
ical.

4 Geometries for verification of the UPF's

Verification tests were made on both single and multi-element geometries. For the
single element geometry, double precision values (16 significant figures) of the nodal
displacement results could be obtained with a FORTRAN "write” statement in the
UserElem routine. However, when running tests on the multi-element geometries,
the displacement values of each node were not as easily identifiable with the same
precision as for the single element geometry. This was due to the non-commercial
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code relying on importing a mesh and loading conditions from Abaqus. While a
mesh done in Abaqus may be made to look the same as one created in ANSYS,
the nodal numbers in the meshes created with the two different programs will most
likely vary. Therefore, all nodal displacement values from each program would have
had to be identified manually for comparison with the nodal displacement values
obtained using the other program. Thus, identifying the values of the two meshes
would be an incredibly time consuming task. Instead, for multi-element geometries,
certain nodes such as those with applied loads were identified. Thereby the nodal
displacement values of a few selected and already identified nodes could be compared
and the assumption was made that if the comparison was accurate for those nodes,
it would also be accurate for the entire geometry. This however restricted the nodal
displacement results to be obtained with a maximum of 8 significant figures for the
multi-element geometries instead of 16, as obtained for the single element geometry.
The material parameters for the verification tests were set as:

e Young’s modulus = 2.1 GPa
e Poisson’s ratio = 0.3

which corresponds to a generic polymer [3].

4.1 Single element cube, 10 substeps

When developing the UPFs, a 1 cm? cube, meshed with a single 8-node brick element,
was the geometry used to verify the code. This allowed for the possibility to easily
identify and compare the numerical values of the displacements for all nodes within
the element. This was done by using MATLAB to normalize the displacement values
by dividing the nodal displacement values from one program with the respective nodal
displacement values from the other program. The division results’ deviation from 1
indicates the deviation in the displacement results from the two programs. The cube
was constrained to be fixed on the bottom face parallel to the XZ-plane and was
loaded with 10000 N in X-direction on two nodes on the same edge, on the top of the
cube. This results in three-dimensional displacements in the four nodes on the top of
the element, and zero displacements in the four nodes on the bottom of the element.
A total of twelve easily identifiable displacement values that could be compared for
the non-commercial code and the results from ANSYS using the UPFs.

For the solution obtained with 10 load steps, the deformed reference geometry of
the single element cube is shown in Figure 6 and the calculated, undeformed geometry
is shown in Figure 7. The nodal displacement values from ANSYS using the UPFs
are presented in Table 1 and the nodal diplacement values from the non-commercial
code are presented in Table 2. The comparison by division for the two programs are
shown in Table 3. Note that the constrained nodes with zero displacement are not
included in the comparison. The force and displacement convergence history for 10
substeps are shown in Figures 8 and 9 respectively.
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R18.0

Academic
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Figure 6: The desired reference geometry after deformation due to loading of the single
element cube using 10 substeps.

ANSYS

R18.0
Academic
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0,0025 0,0075

Figure 7: The calculated undeformed geometry of the single element cube using 10
substeps.
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Table 1: Nodal displacement values [m] using ANSYS and the UPFs of the single
element cube using 10 substeps.

x-direction

y-direction

z-direction

-3.557660575560441E-003

-2.086249656243696E-003

-6.264697490331612E-004

-5.191212002281372E-003

1.276745956855816E-003

3.180207769038435E-004

-5.191212002281373E-003

1.276745956855816E-003

-3.180207769038434E-004

-3.557660575560442E-003

-2.086249656243696E-003

6.264697490331605E-004

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

Table 2: Nodal displacement values [m] using the non-commercial code of the single
element cube using 10 substeps.

x-direction

y-direction

z-direction

-5.191210136391365E-003

1.276745699720877E-003

-3.180192398238751E-004

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

-5.191210136391365E-003

1.276745699720879E-003

3.180192398238761E-004

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

-3.557660660274990E-003

-2.086248780313879E-003

6.264708011656163E-004

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

-3.557660660274992E-003

-2.086248780313878E-003

-6.264708011656145E-004

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

Table 3: Comparison of nodal displacement values for the two programs using 10

substeps.

x-direction

y-direction

z-direction

0.999999976188131

1.000000419858756

0.999998320540317

1.000000359432571

1.000000201398710

1.000004833292377

1.000000359432571

1.000000201398712

1.000004833292379

0.999999976188132

1.000000419858756

0.999998320540313
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Figure 8: Force convergence history for the single element cube using 10 substeps.
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Figure 9: Displacement convergence history for the single element cube using 10 sub-
steps.

4.2 Single element cube, 1000 substeps

To investigate what effect the number of load steps had on the solution, the inverse
form of the single element cube was calculated with both 10 and 1000 load steps.

As the graphical result does not show a noticeable difference between 10 and 1000
substeps, and as the convergence plots renders unreadable for 1000 load steps, only
the deformation values are included in the results from the calculations performed
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using 1000 substeps. However, it has been confirmed that, as for the calculation using
10 substeps, the solution converged after two equilibrium iterations in every substep.
For the solution obtained with 1000 load steps, the nodal displacement values from
ANSYS using the UPFs are presented in Table 4 and the nodal diplacement values
from the non-commercial code are presented in Table 5. The comparison by division
for the two programs are shown in Table 6. Note that the constrained nodes with zero
displacement are not included in the comparison.

Table 4: Nodal displacement values [m] using ANSYS and the UPFs of the single

element cube using 1000 substeps.

x-direction

y-direction

z-direction

-3.557660650918946E-003

-2.086248813918446E-003

-6.264707738415352E-004

-5.191210138589678E-003

1.276745703404189E-003

3.180192250142727E-004

-5.191210138589677E-003

1.276745703404189E-003

-3.180192250142723E-004

-3.557660650918950E-003

-2.086248813918445E-003

6.264707738415335E-004

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

Table 5: Nodal displacement values [m] using the non-

element cube using 1000 substeps.

commercial code of the single

x-direction

y-direction

z-direction

-5.191210136391567E-003

1.276745699721073E-003

-3.180192398239316E-004

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

-5.191210136391567E-003

1.276745699721075E-003

3.180192398239341E-004

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

-3.557660660275040E-003

-2.086248780313786E-003

6.264708011656092E-004

0.000000000000000E4-000

0.000000000000000E4-000

0.000000000000000E4-000

-3.557660660275040E-003

-2.086248780313784E-003

-6.264708011656083E-004

0.000000000000000E+-000

0.000000000000000E+-000

0.000000000000000E+-000

Table 6: Comparison of the nodal displacement values of the single element cube for
the two programs using 1000 substeps.

x-direction

y-direction

z-direction

0.999999997370156

1.000000016107697

0.999999956384123

1.000000000423429

1.000000002884767

0.999999953431555

1.000000000423429

1.000000002884769

0.999999953431562

0.999999997370157

1.000000016107695

0.999999956384119
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4.3 Simple cantilever

After the desired results had been obtained with the single element mesh, a multi-
element geometry was used to compare the nodal displacements from the results ob-
tained using the non-commercial code to the results obtained using the UPFs in
ANSYS. The geometry used for this comparison was a simple three-dimensional can-
tilever. This box shaped geometry had the dimensions 0.5 x 0.1 x 0.015 meters and
was meshed with an element size of 2 mm, resulting in a total of 100000 elements
arranged in straight lines (with different nodal numbers) for the mesh generated by
ANSYS and the mesh generated by Abaqus. The cantilever was constrained to be
fixed in space on one of its 0.1 x 0.15 surfaces. A single concentrated load of -500 N
was then applied in y-direction in one of the corners on opposite side of the constraint.
This allowed for both bending and twisting of the cantilever. The inverse form of the
cantilever was calculated using 10 load steps.

The deformed reference geometry of the simple cantilever is shown in Figure 10 and
the calculated, undeformed geometry is shown in Figure 11. The nodal displacement
values of the loaded node in x-, y- and z-direction from ANSYS using the UPFs are
presented in Table 7. The nodal displacement values of the loaded node in x-, y- and
z-direction from the non-commercial code are presented in Table 8. The comparison
by division for the two programs are shown in Table 9. The force and displacement
convergence history for 10 substeps are shown in Figures 8 and 9 respectively.

ANSYS

R18.0

Academic

0,000 0,050 0,100 () Z‘/L 4
Il N

0,05 0,075

Figure 10: The desired reference geometry after deformation due to loading of the
simple cantilever.
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ANSYS

R18.0

Academic

0,000 0,050 0,100 ) Z‘/L )(
I

0,025 0,075

Figure 11: The calculated undeformed geometry of the simple cantilever.

Table 7: Nodal displacement values [m] using ANSYS and the UPFs of the simple
cantilever.

x-direction y-direction z-direction

-0.14492121 0.30465329 -0.012462921

Table 8: Nodal displacement values [m| using the non-commercial code of the simple
cantilever.

x-direction y-direction z-direction

-0.144921218805715 0.304653301397463 -0.01246292189137784

Table 9: Comparison of the nodal displacement values of the simple cantilever for the
two programs.

x-direction y-direction z-direction

0.999999939237918 0.999999962588743 0.999999928477620
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Figure 12: Force convergence history for the simple cantilever using 10 substeps.
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Figure 13: Displacement convergence history for the simple cantilever using 10 sub-
steps.

4.4 Cantilever with hole

To test the mesh dependency, a 4 mm in diameter hole was made in the simple
cantilever geometry. This disturbance causes the mesh to no longer be arranged in
straight lines in order to avoid sharp angles when meshing the elements around the
hole. As Abaqus and ANSYS use different meshing algorithms, the layout and the
quantity of the elements differ for the meshes generated by the two programs. The

34



results may then give an indication of the mesh dependency of the solution. The
mesh size was once again set to 2 mm for both programs, resulting in 98568 elements

when using the ANSYS meshing tool and 120976 elements when using the Abaqus
meshing tool. The difference between the two meshes can be seen in Figure 14 and 15.
As can be seen in these images, the ANSYS mesh has a distortion from the straight

arrangement around the hole whereas the disturbance covers the entire xz-plane for
the Abaqus mesh. Loads and constraints were applied in the same manner as for the

le cantilever and the inverse form of was calculated using 10 load steps.
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Figure 15: The mesh generated in Abaqus for the cantilever with a hole.

The deformed reference geometry of the cantilever with a hole is shown in Fig-
ure 16 and the calculated, undeformed geometry is shown in Figure 17. The nodal
displacement values of the loaded node in x-, y- and z-direction from ANSYS using
the UPFs are presented in Table 10. The nodal displacement values of the loaded
node in x-, y- and z-direction from the non-commercial code are presented in Table
11. The comparison by division for the two programs are shown in Table 12. The
force and displacement convergence history for 10 substeps are shown in Figures 18
and 19 respectively.
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Figure 16: The desired reference geometry after deformation due to loading of the
cantilever with a hole.
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Figure 17: The calculated, undeformed geometry of the cantilever with a hole.
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Table 10: Nodal displacement values [m] of the cantilever with a hole using ANSYS

and the UPFs .

x-direction y-direction

z-direction

-0.14752975 0.30590555

-0.0128501

Table 11: Nodal displacement values [m] of the cantilever with a hole using the non-

commercial code.

x-direction y-direction

z-direction

-0.148471335431262

0.306736625123636

-0.01280491284032559

Table 12: Comparison of the nodal displacement values of the cantilever with a hole

for the two programs.

x-direction y-direction

z-direction

0.993658133211188

0.997290590508059

1.003528892405429
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Figure 18: Force convergence history for the cantilever with a hole using 10 substeps.
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Figure 19: Displacement convergence history for the cantilever with a hole using 10
substeps.

5 Example geometries for various applications

After the UPFs had been verified, a number of geometries were tested to show that
inverse motion form finding can be used for various applications in different fields.
The method could potentially be applicable to simple designs such as furniture to
more advanced designs such as aircraft. Note that this section only suggest uses
for the inverse motion form finding model by demonstrating with simplified designs
and loading situations. To implement the model on actual designs would require a
substantial amount of research around defining the problems, boundary conditions,
loads etc. This section is simply meant to inspire ideas for situations where inverse
motion form finding may be of use.

Also noteworthy is that some of these applications may require further development
of the model in order to handle phenomena such as anisotropy and body forces.
Additionally as the model is restricted to only allow for constant traction, dynamic
load situations such as the cyclic loads on aircraft would require further analysis.
However, the inverse model could be used to calculate the design dimensions for an
average load and the calculated geometry could then be used for further analysis.

5.1 Office partitioning wall support

To show that the inverse motion model could be applicable on simple designs seen
around us in our everyday life, an approximate representation of the metal supports on
the partitioning walls found in our office, as seen in Figure 20, were modelled. With
the inverse motion model and a presumed known weight of the partitioning walls,
the supports could be made out of a polymer based material, in this case polyvinyl
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chloride (PVC), with lower stiffness, but for a potentially lower price. The supports
would still maintain its desired design shape to allow for a sufficient surface area in
contact with the floor to prohibit eventual denting of the floor due to the weight of the
partitioning wall and the contact pressure between the supports and the floor. The
PVC was modelled with an elastic modulus of 3.0 GPa and a Poisson’s ratio of 0.4
[14],[15]. The partitioning wall was assumed to exert a downward distributed force of
50 N on the top surface of each support, as seen in Figure 20. Constraints A and B
in Figure 21 restricted movement of the two ends in y- and z-direction. Constraint
C restricted movement of the top surface in x-direction. Friction forces from the
floor surface were assumed to be negligible. The geometry was meshed with 123602
elements.

Figure 20: Partitioning wall support.

The deformed reference geometry of the office partitioning wall support is shown
in Figure 21 and the calculated undeformed geometry is shown in Figure 22.
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Figure 21: The desired reference geometry after deformation due to loading of the
office partitioning wall support.

ANSYS

R18.0
Academic

®
¥
0,000 0,050 0,100 ()
| I ]

0,085 0,075

Figure 22: The calculated, undeformed geometry of the office partitioning wall support
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5.2 Aircraft passenger window

An application of the inverse motion model for use in a technologically advanced
system is to calculate the shape of the cutouts for passenger windows in the frame of
an aircraft. Assuming that the the window itself is manufactured in a certain shape,
the form of the cutout could be calculated to fit the glass during flight when the forces
acting on the aircraft slightly deform the aircraft frame. Very rough assumptions were
made regarding the boundary conditions for this example as obtaining information
about the actual loading situation for an aircraft window would require extensive
research. The modelled cutout can be seen in Figure 23. The bottom boundary is
restricted from moving in z-direction, the right boundary is restricted from moving
in x- and y-direction and the left boundary is restricted from moving in x-direction.
A vertical force of 10000 N is applied to the left boundary and a horizontal force of
10000 N is applied to the top boundary. The frame is assumed to have a Young’s
modulus of 70 GPa and a Poisson’s ratio of 0.35. This corresponds to the properties
of aluminum [16], which is the most widely used metal on aircraft [17]. The geometry
was meshed using 98378 elements.

The deformed reference geometry of the aircraft passenger window is shown in Fig-
ure 23 and the calculated undeformed geometry is shown in Figure 24. The resulting
total deformation has been scaled by a factor of 270 in Figure 24.

ANSYS
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Figure 23: The desired reference geometry after deformation due to loading of the
aircraft passenger window frame.
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Figure 24: The calculated, undeformed geometry of the aircraft passenger window
frame.

0,000 0300 0,600 (m)
| |

0,150 0450

5.3 O-ring

Another application of the inverse motion model, that could be of use in many different
products and industries, is the cross-section geometry of O-rings. O-rings are placed in
grooves and used as seals between two component surfaces, typically when hydrostatic
pressure is present. Higher pressure between the O-ring and it’s adjacent surfaces
gives a better sealing capability. Thus, a smaller contact surface consequently leads
to a better seal. However, a contact surface that is too small may cause leakage
of the pressurised fluid due to surface roughness of the O-rings and the adjacent
surface allowing the fluid to flow through pores from the high-pressure region to the
low-pressure region [18]. By using Inverse motion, O-rings could be designed for
applications where the loading conditions of the O-rings are known, thus allowing to
design O-rings that in their loaded state will attain a specified contact area.

The modelled O-ring has a 10 mm radius, and a 2 mm thickness in it’s desired
loaded state. It’s Young’s modulus is set as 5 MPa to represent the behaviour of Nitrile
rubber [19], which is commonly used in industrial O-rings and has a negligible decrease
in Young’s modulus, due to the viscoelastic behaviour of rubber, during loading [20].
As can be seen from Figures 25 and 27 the O-ring is loaded with a pressure of 1 MPa
on the flat design surfaces on both sides of the torus-like structure. A strip along the
inner radius of the O-ring is fixed in all directions. The geometry was meshed with
131796 elements.

The deformed reference geometry of the O-ring is shown in Figure 25 and the
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calculated undeformed geometry is shown in Figure 26. A cross-section view of the
deformed reference geometry is shown in Figure 27 and a cross-section view of the
undeformed calculated geometry is shown in Figure 28
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Figure 25: The desired reference geometry after deformation due to loading of the
O-ring.
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Figure 26: The calculated, undeformed geometry of the O-ring.
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Figure 27: Cross-section of the desired reference geometry after deformation due to
loading of the O-ring.
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6 Discussion

The purpose of this study was to explore ways of implementing the previously de-
veloped inverse motion form finding model into commercial software. By doing this
the goal was to gain a user friendly way of employing the model for static analysis
as well as writing functioning subroutines that can be used for further research and
development.

The implementation process was associated with a number of obstacles that needed
to be overcome in order to develop the UPFs. With little to none prior experience
with ANSYS on site, the information on how to utilize UPFs was initially almost
exclusively found through standard internet search engines. The information found
was limited and outdated and the reason was discovered to be that the official infor-
mation supplied by ANSYS requires access to the ANSYS Customer Portal, to which
access was not initially given. With successful access to the ANSYS Customer Portal,
more information was found on prerequisites for utilizing the UPFs, such as specific
FORTRAN and C++ compilers and the UPF extension. This knowledge, to ensure
access to the ANSYS Customer Portal, is valuable for future developers of the UPFs.

Once the UPF extension was operating as it should, implementation was quite
straightforward. The non-commercial code developed at the Division of Solid Me-
chanics was used as a blueprint, which was then translated from FORTRAN 90 to
FORTRAN 77 and modified to fit into the ANSYS Mechanical interface.

As the model itself had already been developed, verification of the results obtained
with the model implemented in ANSYS could easily be made by comparing the values
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obtained from ANSYS with values obtained with the non-commercial code developed
at the Division of Solid Mechanics. The comparisons between the results obtained
with ANSYS and the non-commercial code, seen in Tables 3, 6 and 9, show that
the comparison values differ from 1 on the 6th to 8th significant value for the single
element cube using 10 substeps, on the 8th to 10th significant value for the single
element cube using 1000 substeps and assumably around the 8th significant value
for the multi-element simple cantilever. For these three cases, the difference may
be caused by the different convergence criterion used in the two programs. In the
non-commercial code, acceptable convergence is reached when the dot product of
the residual vector, from Equation (2.42), with itself is below 107%. The ANSYS
solver uses both a force criteria as well as a displacement criteria to reach acceptable
convergence which are dependent on the degrees of freedom in the system. Both codes
use what have been deemed an acceptable, but different, convergence tolerance and
the difference between the nodal displacement values are believed to be caused by this
difference in the solution process.

The comparison between the ANSYS results and the results obtained using the
non-commercial software differed more for the simulation of the cantilever with a hole.
Here the comparison values differ from 1 on the 3rd significant value. The difference
was most likely caused by the dissimilarity in the meshes created by ANSYS and
Abaqus as seen in Figures 14 and 15. No connection has been found that would
indicate that the small change in geometry (the hole) would cause such a difference
in the results from the two programs, the mesh is therefore with high certainty the
largest contributor to this disparity. The difference could be mitigated by using meshes
consisting of a larger number of elements. However, due to limited computational
power, this could not be tested. For future development, this issue could be overcome
by running the solver on a more powerful computer or a cluster network.

As seen from the force and displacement convergence history plots, convergence
was achieved with two to three iterations per substep. This corresponds to the fast
convergence that can be expected from a Newton-Raphson scheme [21] and is also an
indication that entities such as the the material stiffness matrix are correctly defined.

Note that in all simulations used for verification of the UPFs, the deformation
magnitude is relatively large. The model does not handle phenomena such as plasticity
and fracture and therefore these large deformations does not necessarily depict the
exact physical behaviour of the loaded structures.

The three examples of designs where inverse motion can be applied show that the
model can be used on both low- and high technology designs, the office partitioning
wall support and the aircraft window frame, as well as in common industrial compo-
nents such as O-rings. However, the resulting geometries are arguably more complex
than their design shapes and can therefore be more difficult and costly to manufac-
ture, depending on the manufacturing method. The exception would be the O-ring,
which can be manufactured by extrusion. Extruding the resulting geometry would not
necessarily be more complex than extruding a circular cross-section. As previously
stated, the example geometries are simplified in terms of boundary conditions, and
more research is needed regarding various boundary conditions such as the stresses
in the aircraft frame during flight and the interaction with the groove walls and the
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O-ring. The examples may however give inspiration for design areas where the inverse
motion form finding model may be utilized.

Another interesting area for further development of the implemented UPFs could
be to include topology optimization as suggested by Wallin and Ristinmaa [3]. Tt is
not certain if this could be fully implemented within ANSYS or if ANSYS would need
to run simultaneously with an external program. However, UPFs should be able to be
used to write your own design-optimization algorithm which calls the entire program
as a subroutine according to the ANSYS Help Documentation.

Other things that could be researched further and implemented in the UPFs are
phenomena such as plasticity and thermal loading as well as different element types.
The model has only been implemented for 8-node brick elements and the ANSYS
meshing tool is not always capable of creating a mesh solely consisting of brick ele-
ments, as complex geometries may require some brick elements to be split into tetrahe-
drons. Therefore, to make the model applicable on more complex geometries, 4-node
tetrahedron elements could be implemented for further usability.

7 Conclusion

The inverse motion form finding model could be implemented ANSYS Mechanical.
The comparison between the results obtained with ANSYS and the results obtained
with the non-commercial code show that the implementation closely represents the
previously developed model. However, slight differences may be observed, likely as a
result of different solution methods, and larger differences may be observed when the
meshes used in ANSYS and the non-commercial code are variant.

One of the more time consuming challenges during this research was the initial
problem of calling the UPFs into ANSYS as clear guidance on how to do so was
not easy to come by. When knowing how to proceed to utilize UPFs in the ANSYS
program, implementation of element and material behaviour was shown to be rather
straightforward.

The work described in this report and the UPFs developed in parallel may be
used as a base for further development of the inverse motion form finding model in
commercial software.
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8 Appendices
A Getting started with UPFs

There are supposedly several ways of using the user programmable features. Here is a
description of how to get started with the program version and UPF linking method,
the UPF extension, that was used during the time of this research.

A.1 Operative system

User programmable features are not necessarily restricted to a single operative system.
UPFs should be usable on both Windows and Linux systems but in order to use the
UPF extension for version 18.0 of ANSYS Mechanical, the operative system has to be
Windows. Windows 10 has been confirmed to be sufficient to use the UPF extension,
other versions of Windows have not been tested. It may however be possible to use
the UPF extension with other versions of Windows.

A.2 Compilers

In order to compile and link your FORTRAN files into ANSYS, specific versions are
needed for the FORTRAN and C++ compilers. Therefore, the user needs to install
Visual Studio 2012 Professional to get the necessary MS C++ compiler, as well as
the Intel FORTRAN 15.0.2 compiler, which may be downloaded packaged with Intel
Parallel Studio XE 2015 update 2. Both of these compilers require paid licenses.
However, a 30-day trial license may be acquired for Visual Studio 2012 Professional
by joining the Dev Essentials program on the Microsoft website

https://www.visualstudio.com/vs/older-downloads/

and students who wish to utilize UPFs, can acquire the Intel FORTRAN com-
piler for free through Intel’s website

https://software.intel.com/en-us/parallel-studio-xe/choose-download#
parallelstudioxe

Note that this is not a direct link to where the correct compiler can be found
as you need to create and sign in to an account in order to download the compiler.
It is recommended to install Visual Studio before installing the FORTRAN compiler
in order to assure that the two compilers can cooperate. Also note that these free
versions may be subjects of special terms of use.

A.3 ANSYS software

The ANSYS software can be bought and downloaded from the ANSYS Customer Por-
tal. In addition, the UPF extension may be downloaded from the ANSYS appstore at:
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https://appstore.ansys.com/search?q=upf

The UPF extension is currently supported for four versions of ANSYS. Those
are ANSYS 17.0, 17.1, 17.2 and 18.0. Here version 18.0 was used but the other
versions are believed to follow a similar procedure to get the code to work.

In the folder containing the installation files, downloaded from the ANSYS Cus-
tomer Portal, there is an executable file called "InstallPreReqs”. Run this executable
file as an administrator before installing ANSYS. Once the installation of the prereq-
uisites is complete, run the executable file called "setup” as an administrator. This
starts the installation process. The installation is pretty straight forward. However,
pay attention and make sure that the option to install "ANSYS Customization Files
for User-Programmable Features” is checked.

Once the ANSYS installation is complete, run Workbench 18.0. In the top menu
of the workbench window, click "Extensions > Install extensions...”. Select the file
named UPF.wbex located in the UPF folder downloaded from the ANSYS appstore
and press "Open”. Then go to "Extensions > Manage extensions...” and make sure
that the UPF extension is loaded. You may right-click the extension in this window
and select "Load as Default” if you want to load the extension as default for all your
projects.

You may now create a project, or open an existing project as a static structural
analysis system. When opening your project in the Mechanical module, a UPF menu,
as seen in Figure 29, should have been added.

User Programmable Features ET ﬂ

Figure 29: Screenshot of the UPF menu in the Mechanical module

The first of the three buttons is used to verify that the correct compilers and
operative system is installed. The second button is what you use to include a UPF in
your calculations. The third button opens a brief tutorial for the usage of UPFs.

To use a UPF, press the second button. An object called "UPF1” is added to your
Outline tree under Static Structural. In "Details of UPF1” click the "File” box, which
is highlighted yellow. Select your desired UPF and make sure that it has the correct
file name format, such as usermat.F or UserElem.F, and that the subroutine of the
UPF is called usermat or userelem respectively. If everything is correct, the box called
"UPF routine” in Details of UPF will show the correct routine type.

The first time you Solve your system with UPF's included, a window will pop-
up asking you to install the .NET Framework 3.5. Install this library framework,
clear your failed results and press Solve once again. Your UPF files should now be
considered in the solution. To double check that the UPF has been called, the Solution
Information in the Results will show the text "Note - This ANSYS version was linked
by Licensee”. To check even more thoroughly, make a write statement such as

write(*x,x) ’My UPF test.’

in the UPF code and check the Solution Information for the write output.
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B Inputs to utilize the inverse motion UPF's

The two UPFs developed for this research are limited to only work for some non-
general systems. After setting up the UPF extension as described in Appendix A,
load both the usermat and the UserElem UPFs into ANSYS Mechanical.

The UPFs are required to be used on 8-node brick elements. Therefore, when
creating the mesh in ANSYS Mechanical, right-click "Mesh” in the Outline tree, select
Insert > Method. In the details of your method, set the "Free Face Mesh Type” option
to "All Quad” and the "Element Midside Nodes” option to "Dropped”. This enables
the 8 node-brick elements needed for the UPFs.

Apply loads and supports to your geometry in ANSYS Mechanical as you would
for the forward motion problem. Note that not all types of loads and supports are
applicable when using these UPFs. Note also that the deformation obtained in the
results is expected to be opposite of the load directions.

In the Outline tree, select ”Analysis Settings” and do the following. Change ”Auto
Time Stepping” to "Off” and set the "Define by” to "Substeps”. Then, select the number
of substeps (number of load increments) that you want to use when solving your
system. Then, change "Solver Type” to "Iterative” and enable for large deformations
by setting "Large Deflections” to "On”. Under "Nonlinear Controls” in the Analysis
Settings, set "Newton-Raphson Option” to "Unsymmetric”.

In the Outline tree, under Model > Geometry, right-click the geometry, by default
called "SYS/solid”. Select "Insert > Commands”. Paste the following into the created
Command window

'Young’s modulus:
E=2100000000

Poisson’s ratio:
nu=0,3

ET,1,USER300,1

USRDOF ,DEFINE,UX,UY,UZ

USRELEM, 8,3,BRICK,3,43,112,0,8,3,1
R,1,E,nu 'm, N

Where the values 2100000000 and 0.3 may be set to other values for the Young’s
modulus and Poisson’s ratio.

With these setting you should be able to solve your static problem using the inverse
usermat.F and UserElem.F UPFs developed for this research.
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